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About This Manual 
Introduction 

This User Guide is intended for Total Recall Max  end-users who will be using 
the system to record and play back recorded data. 

�  See the Total Recall Max  Installation and Administration 
Guide for information about installation and system 
configuration. 

We recommend that you keep a copy of this user guide handy for quick 
reference. 

Conventions and Terminology 

Conventions 

References 

References to other manuals or other parts of this manual are indented, 
formatted in blue text, and marked with a hand symbol: 

�  Reference example 

Notes 

Notes are indented, formatted in blue text with light grey borders, and marked 
with a note symbol: 

 Note example 

Warnings 

Warnings are indented, formatted in blue text with light grey borders, and 
marked with a warning symbol: 

 Warning example 

Procedures 

Procedural lists describing tasks are marked with a ‘cogs’ icon, and the purpose 
of the procedure is formatted in bold italic text: 
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 Procedure Start Example: 

1. Procedural step example 

Terminology 

The following table lists some writing style conventions used in this manual 
and their associated meanings. 

Example Meaning 

‘Select OK to save 
your settings’ 

Highlight (position the cursor over) the OK screen 
button, and press the <SELECT> key on the control 
panel 

‘Select a date from the 
list…’ 

Highlight the relevant data field, and press the 
<SELECT> key repeatedly to cycle through the 
available options, until you reach the required value 

‘Check the Recording 
Period check box’ 

Highlight the relevant check box, and press the 
<SELECT> key to populate it with a check mark 

‘Enter the IP 
address…’ 

Highlight the relevant data field, and enter the IP 
address using the numeric keypad on the control 
panel 
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Total Recall Max 
Overview of Total Recall Max 

About Total Recall Max 

What is Total Recall Max? 

Total Recall Max  is a compact, cost-effective and self-contained digital voice 
logger and recorder that records and provides secure storage for over 20,000 
hours of calls and/or other audio signals. Call information is presented on a 
colour TFT Liquid Crystal Display (LCD). 

Contained in a 19” Rack Mount unit, Total Recall Max ’s simple control panel 
and intuitive menu system means it is easy to configure and operate, either 
directly or remotely via a network (using the supplied Remote Manager  
software). 

Record on Demand software (also supplied) may be installed onto users’ PCs 
to allow limited control over what is recorded on their line. 

Depending on network type and configuration, Total Recall Max  can also 
record the telephone numbers of incoming and outgoing calls, the time and date 
of the call, the duration of the call, and reference to a specific channel number. 
All of this information can be used to search and retrieve calls from the internal 
database or archived call data. 

Features 

·  Record analog, VoIP or ISDN telephone conversations 

·  Record other analog audio signals, such as two-way or broadcast radio 

·  20,000 channel hours recording capacity 

·  Secure and tamper proof recording format 

·  Export to MP3 and WAV format 

·  Policy based recording control 

·  Archive recordings to a Network Drive, DVD or CD for permanent backup 

·  One-click real-time monitoring of calls, locally or remotely 

·  Powerful search capability 

·  Feature-rich player capable of playing multiple recordings synchronised in 
time 

·  Remote access, monitoring and management software included 

·  Compact, self-contained, easy to install and operate 
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Getting to Know TR 

Total Recall Max  is simple to operate, is fully self-contained and can be 
operated using the built-in controls and display panel.  

It is not necessary to attach a PC and monitor as a management console for the 
recorder. 

Front Panel 

 

Headphone Jack 

This is a standard 3.5mm audio jack for connection of headphones or external 
speaker, volume controlled. 

Line Output Jack 

This is a standard 3.5mm audio jack for connection to a tape recorder or the line 
input of a PC. This output is not volume controlled. 

Volume Control 

A thumb wheel to adjust internal speaker volume. 

DVD/CD Writer 

A standard DVD/CD read/write unit with standard DVD player/recorder 
controls. 

Speaker Grill  

This is a grill that is located at the bottom left of front panel. It protects the in-
built speaker. 

Cooling Fan Vent 

This is an opening that is located at the bottom left centre of front panel and is 
protected by a grill. It acts as an air intake for the unit. 
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On/Off Key Switch 

The On/Off Key Switch is located on the left side of the front panel. The Key 
Switch is used to start the unit. This switch works only what the ON/OFF 
switch at the rear of the unit is in ON position. 

 Keep the pair of keys in a safe place as they are unique to the lock 
supplied with your unit. Lost keys can not be replaced without 
replacing the key lock. 

Rear Panel 

 

Network Connectors 

LAN 1 and LAN 2 are two standard RJ45 sockets (8P8C) which can be used to 
connect the unit to a Local Area Network (LAN) or directly to a PC via a cross-
over cable. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 

Analog Line Connectors  

The DSP 1 to DSP 6 groups of four connectors are RJ12 (6P6C) connectors 
which can be used to connect analog lines for the purpose of recording calls on 
the lines. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 
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ISDN Link Connectors 

Link 1 to Link 4 are pairs of RJ48 connectors which can be used to connect 
ISDN links for the purpose of recording calls on the links. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 

PBX CDR Feed 

This is a standard RS-232 serial port which can be used to connect to a PBX for 
the purpose of collecting Call Detail Records (CDR’s). 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 

Modem 

This is a standard RS-232 serial port which can be used to connect to a modem 
for the purpose of remote monitoring and management. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 

IEC Power Connector 

This is a standard IEC 90V - 260V AC power cable socket. 

On/Off Switch 

This switch controls the power to the power supplies. To start the recorder, first 
set this switch to the ON position, then use the ON/OFF key switch on the front 
panel to power the recorder. 

Control Panel 

 

LCD Display  

The colour TFT LCD displays the various screens, menus and dialogs. After 
two minutes of keypad inactivity, the LCD backlight automatically switches 
off, to extend the life of the backlight (the recorder continues to function 
normally). 

Pressing any key illuminates the LCD backlight. 
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Playback and Navigation Keys 

The playback and navigation keys are used to control the playback of recorded 
calls, and to navigate the screen menus.  

�  See the Operation section on page 11 for further information. 

Power and Hard Drive Activity LEDs 

�  Green is the ‘Power On’ indicator.  

�  Red indicates hard drive activity. 

If the LCD backlight has switched off due to inactivity, the green LED flashes 
continuously every two seconds. Pressing any key illuminates the LCD 
backlight and the LED stops flashing. 

Operation 

Power 

Total Recall Max  can only be shut down by a user with administrator 
privileges. It is not necessary for normal users to shutdown and power the unit. 

If  Total Recall Max  is powered off without following the proper procedure, 
database records that are open at the time may be irreversibly damaged. 

For this reason Total Recall Max  must always be shut down properly using the 
System Shutdown function. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 

Using the Control Panel 

MENU Key 

Use the <MENU> key to move between the three main screens, the Logging 
Screen, the Search Screen, and the Options Menu.  

 To move between main screens:  

·  Press the <MENU> key whilst at ‘root level’ of any of the main screens 
(that is, with no dialogs open). 

When <MENU> is pressed with a dialog open, the cursor either moves straight 
to either OK or Cancel, or simply closes the dialog, depending on the contents 
of the dialog. 

The system beeps each time the <MENU> key is pressed. 

SELECT Key 

Use the <SELECT> key to start an operation associated with a highlighted 
option or menu item, and to confirm requests. 
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Up and Down Arrow Keys 

Use the �  (up) and �  (down) arrow keys to navigate sequentially within a 
menu or dialog. With each �  or �  key press, the cursor moves to the next 
option or menu item. 

Press �  to highlight items across the screen from left to right, as well as down.  

Press �  to move right to left (and up). 

The system beeps each time arrow keys are pressed. 

Numeric Keypad 

Use the numeric keypad to enter numerals, and the �  key to tag calls.  

�  See Tagging on page 22 for information about tagging calls. 

Playback Control Keys 

Use the playback control keys to navigate through a call during playback.  

The control keys operate in the same way as the buttons on a CD player. They 
can be used to play, pause, stop, fast-forward and rewind a call. 

�  See Playback on page 22 for information about using the 
playback control keys to play calls. 

The �  (stop) key can also be used to lock the user interface. 

To lock the user interface, press �  in either of the three 3 main screens 
(Options, Logging or Search), whilst not listening to a call. 

This overrides the normal 2 minute timeout required for the user interface to 
lock automatically. 

 The padlock icon, which appears in the top right hand corner on the 
LCD screen, displays in the closed position () when the user 
interface is locked, and the open position () when it is unlocked. 

Using the Graphical User Interface 

Using the GUI 

The Total Recall Max  Graphical User Interface (GUI) features a cursor that is 
moved around the screen using the �  and �  keys. 

When the cursor is positioned on an interactive screen item (such as a screen 
button or a check box), the object becomes highlighted. Pressing <SELECT> 
then executes the function that is associated with that screen item. 

Various methods are used to indicate that screen items are currently 
highlighted. 
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Buttons 

Screen buttons (for example, menu buttons and OK and Cancel buttons) ‘pop 
up’ when they are highlighted, and the button text is shown surrounded by a 
blue border. 

Standard screen button:  

 

Highlighted screen button: 

 

Press the <SELECT> key to ‘press’ highlighted screen buttons. 

Calls 

Calls are shown highlighted when selected. Press <SELECT> or �  to play 
highlighted calls. 

Data Fields 

Data fields are shown in highlighted when selected and can be edited. 

Use the numeric keypad to enter values for numeric data fields. If you enter the 
wrong value, simply enter another value and it will overwrite the existing value. 

 Some data fields will clear the current value on the first key press. 

Use the <SELECT> key to cycle through available values for data fields with 
pre-populated options. 

Check Boxes 

Check box text is shown with a border when selected. 

Press the <SELECT> key to place a check in the check box (referred to in this 
manual as ‘checking’ the check box). 

Data fields associated with check boxes cannot be populated or edited unless 
the check box is checked. 

Cancelling 

Where it appears, you can select the Cancel button to return to the previous 
screen or dialog without executing the current function. 
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Main Screens 

There are 3 main screens in the Total Recall Max  GUI: 

·  The Options Menu 

·  The Logging Screen 

·  The Search Screen 

The Options Menu 

 

Figure 1 - The Options Menu 

The Options Menu allows access to various system configuration screens, plus 
the maintenance menu and system shutdown function. 

Most options are set during installation by a system administrator, and 
following the initial installation, can generally be left alone – unless there are 
changes to recording requirements, the user base, or the network. 

The Options Menu is only available to users with administrator privileges. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information on the Options Menu. 
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The Logging Screen 

 

Figure 2 - The Logging Screen 

The Logging Screen is a list of ‘current’ calls (calls that are being recorded), 
sorted by start date and time, with the most recent call at the top. 

To access completed calls for playback, use the Search Screen. 

�  See The Search Menu on page 18 for further information. 

The call number, plus the number of active calls, and the total number of calls 
(active calls plus calls in the database) is shown in the bottom left corner of the 
screen (in the format x/y/z – where x is the call number, y is the number of 
active calls, and z is the total number of calls). 

The percentage used (the percentage of the hard disk that is currently taken up 
by calls) is shown in the bottom right corner of the screen. 

Use the �  and �  keys to scroll through the call list in the Logging Screen. 

Columns 

The Logging Screen includes columns for:  

Date 

The date when the call started. 

Time 

The time when the call started. 

Length 

The current length of the call. 
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From  

The originator of the call.  

This may be: 

·  Empty (if there is no ‘calling number’ signalling on the line) 

·  The ‘raw’ calling number, taken directly from the call signalling, if present 
on the line (this may be a numeric phone number, or a SIP ID in the case of 
VoIP networks) 

·  A ‘mapped’ value (alpha and/or numeric), if the calling number has been 
mapped to another value in the Signalling Mapping for the recorder 

�  See the Total Recall Max  Installation and Administration 
Guide for further information about Signalling Mapping. 

To 

The recipient of the call. 

This may be: 

·  Empty (if there is no ‘called number’ signalling on the line) 

·  The ‘raw’ called number, taken directly from the signalling (this may be a 
numeric phone number, or a SIP ID in the case of VoIP networks) 

·  A ‘mapped’ value (alpha and/or numeric), if the called number has been 
mapped to another value in the Signalling Mapping for the recorder 

Channel (Ch.) 

A call direction indicator, plus the number of the recorder channel on which the 
recording is being made. 

Call direction indicators are as follows: 

·  < indicates an incoming call 

·  > indicates an outgoing call 

·  ^ indicates an internal call 

·  ? indicates that the call direction could not be established 

 For ISDN and VoIP calls, calls can come in on any channel, meaning 
channel number information is not particularly important. It is best to 
think about ISDN and VoIP calls in terms of the extensions to which 
(or from which) the calls are being made. 
 
Extensions are configured during installation by the system 
administrator. For analog calls, however, signal sources are 
effectively fixed to channels, so channel information is more 
meaningful. 

�  See the Total Recall Max  Installation and Administration 
Guide for information about how extensions are configured. 
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Marks (C / M) 

·  C indicates a current call 

·  M indicates a call that is being currently monitored 

Live Monitoring 

 

Figure 3 - Live Monitoring from the Logging Screen 

Live monitoring can be used to listen in to current calls. 

 It is only possible to monitor calls if Monitoring has been enabled for 
that extension by an administrator. 

To monitor a current call, highlight the call and press <SELECT>. 

The call is played through the loudspeaker or headphones. 

The letter M is displayed in the Status column and the call is moved to the top 
of the call list. 

To end monitoring, press <SELECT> again. (This does not terminate the call.) 

 For analog channels, if ‘Beep’ is active for the channel that is being 
monitored, both parties hear a beep at regular intervals to indicate that 
the call is being monitored. Beep settings can only be edited by a user 
with administrator privileges. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 
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The Search Menu 

 

Figure 4 - the Search Screen, following a search 

Use the Search Screen to locate calls according to a range of search criteria 
(date, time, channel, telephone number etc.) and to play back calls returned by 
the search. 

Searching 

 To search for calls on the internal hard drive: 

1. Select Search. 

The Search Options dialog displays. 

 

2. Enter search criteria as appropriate (see Using Search Criteria below) and 
select Search. 

An information window displays, summarising the search results. The 
results are listed in the Search Screen. 
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 If more than 1000 results are returned, only the 1000 most recent calls 
are listed. If you wish to see call older than those that are listed, refine 
your search to exclude the most recent calls. 

 To search for calls on a DVD/CD: 

1. Insert the DVD or CD that you wish to search into the Total Recall Max  
DVD/CD drive. 

2. Navigate to the Search Screen. 

3. Select the Search screen button. 

The Search Options dialog displays. 

 

4. Enter search criteria as appropriate (see Using Search Criteria below) and 
select Search Archive. 

The Archive Selection dialog appears. 

 

5. Set Archive Device to DVD/CD and then select the Ok button. 

An information window displays, summarising the search results. The 
results are listed in the Search Screen. 

 

 To search for calls on a Network Share: 

1. Navigate to the Search Screen. 

2. Select the Search screen button. 

The Search Options dialog displays. 



Total Recall Max  – User Guide   

  Page 20 

 

3. Enter search criteria as appropriate (see Using Search Criteria below) and 
select Search Archive. 

The Archive Selection dialog appears. 

 

4. Set Archive Device to Network Share. 

The Type, Path, User and Password parameters for the network share 
must be pre-configured. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 

5. Select the Archive. 

There may be more than one archive on the network share. Each archive 
can contain up to 250,000 recordings. The name of the archive is the date 
when it was created in the following format: yyyymmddhhmm, that is a 4 
digit year, followed by two digit month, day of month, hour of day and 
minute. 

6. Select the Ok button. 

An information window displays, summarising the search results. The 
results are listed in the Search Screen. 

Using Search Criteria 

Various types of information (listed below) can be used as search criteria. 

To search by each criteria type, select the appropriate check box in the Add 
Calls to List dialog, and enter or select the required value/s in the associated 
data field/s. 

·  Date 

Required data: Date From and Date To 

·  Time  
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Required data: Time From and Time To 

 Time criteria can not span 00:00 (midnight). To search a time period 
that spans midnight, either search using date criteria only, or initially 
search up to 23:59 hours on Day 1, and then search from 00:00 hours 
on Day 2. 

·  Number  

Required data: numeric. 

 
The Number search returns any results containing the search string. 

 
For example, with search criteria 2001 in the Number field, the search will 
return any calls to or from telephone number 2001, and also to or from 
numbers 20015, 32001, 620014, etc. 

·  Extension 

Required data: numeric. 

 
The Extension search only returns results that match the search string 
exactly. 

 
For example, with search criteria 2001 in the Extension field, the search 
will return calls to or from extension 2001, and no other calls. 

·  Tag 

Available options: Tagged Only | Untagged Only | Tagged & Untagged. 

The data field defaults to Tagged & Untagged (all calls). 

·  Direction 

Available options: Incoming | Outgoing | Internal | Unknown. 

 
The data field defaults to Incoming.  

 
‘Unknown’ refers to calls that Total Recall Max  is unable to resolve an 
origin and/or a destination for. 

·  Channel 

Required data: numeric. 

 Performing a search with no search criteria entered will return all 
calls on the database or archive. 

Multiple Criteria 

Search criteria are cumulative – only calls that match all specified criteria are 
returned. The more criteria entered, the more specific the result. 

For example, to search for tagged calls made between 6am and 11am from 
extension 2001, use the following search criteria:  

·  Time: 06:00 to 11:00 
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·  Extension: 2001  

·  Tag: Tagged Only 

Playback 

 

Figure 5 - Playing calls from the Search Screen 

Following a search, the results are listed in the Search Screen, sorted by date 
and time, with the most recent call at the top. 

To play a call, highlight it and press <SELECT> or� . 

Press� again to pause playback. 

Press �  to fast-forward.  

Press ��    to skip forward. 

Press �  to rewind. 

Press �  to stop playback. 

Use the thumb wheel on the front panel to adjust the playback volume. 

Progress through the call is displayed as a progress bar at the bottom of the 
LCD display. 

Tagging 

Tagging calls is a way to mark them so that they can be selectively archived 
using the Manual Archive function. 

�  See Manual Archiving on page 24 for further information. 

To tag a call for manual archiving:  

·  Highlight the call in the Search Screen, and press � . 
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To untag a tagged call:  

·  Highlight the tagged call and press � . 

To tag all calls in the list:  

·  Select Tag All . 

To untag all calls in the list:  

·  Select Untag All . 

 You can not tag search results from an archive. 

Archiving 

Total Recall Max  stores call files internally on the hard disk drive. Call files 
can be archived to DVD, CD, or Network Share either manually (whenever 
required) or automatically (at scheduled intervals).  

�  See the Total Recall Max  Installation and Administration 
Guide for further information on Network Shares. 

Approximately 1,000 channel hours can be archived to a standard DVD and 
approximately 180 channel hours to a standard CD, depending on the call 
lengths and the number of sessions used. The number of channel hours that can 
be stored on a Network Share depends largely its disk size. 

It is recommended that calls are archived on a regular basis. Call recording 
continues during the archive process. Progress is displayed on the screen. Other 
recorder functions (except recording) are disabled during the archive process. 

 During the archive process, the clock (top right corner) may stop at 
times. This is part of normal operation. (The screen refresh for the 
clock functions as a lower priority during an archive.) 

 The CD/DVD drawer will open and close during the archive process. 
Attempt to minimise any potential obstructions to the CD/DVD 
drawer opening and closing. 

Storage Media 

Total Recall Max  uses standard DVD+RW and CD-R media for archiving data. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 

Archiving on DVD or CD is performed in sessions. Each session updates the 
disk directory, writes the calls, and closes the archive with an ‘end of session 
marker’. 

Archiving to disc media should be done thoughtfully, as each session marker 
uses approximately 10 MB of disc space. This is equivalent to approximately 
three hours of calls. Therefore, to minimise wasted space, it is advisable to 
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archive as many calls as possible each time you archive, rather than archiving 
smaller numbers of calls more often. 

To maintain compatibility with various CD readers, a maximum of 25 sessions 
is permissible per CD. 

Network Shares 

The Total Recall Max  has an in-built NFS Client and SAMBA Client to access 
NFS and Windows Network Shares. 

Each Network Share can contain more than one archive, each with up to 
250,000 records. The name of each archive is the date and time when it was 
created in the following format: yyyymmddhhmm, that is a 4 digit year, 
followed by two digit month, day of month, hour of day and minute. 

Manual Archiving 

Manual Archiving can be done at any time. 

 To archive manually to DVD/CD: 

1. Navigate to the Search Screen. 

2. Select the calls to archive by searching and/or tagging them. 

3. Insert the DVD or CD you wish to archive to into the Total Recall Max  
DVD/CD drive. 

4. Select Archive. 

The Archive Calls dialog displays. 

 

5. In the Archive Calls field, select the types of call you wish to archive, from 
the following 4 options: 

·  All Calls (all calls currently on the hard disk) 

·  Found Calls (all calls that are currently listed in the Search Screen) 

·  Unarchived Calls (calls that have not been archived in the past) 

·  Tagged Calls 

As archive options are selected, Total Recall Max  displays the number of 
calls and the collective size of the calls (in MB). 

6. Select DVD/CD for Archive Device. 

7. Select OK. 
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 If you have administrator privileges, a confirmation dialog displays 
asking if you would like to remove the calls that are archived from 
the hard disk. Select Yes to remove archived calls from the hard disk, 
or No to leave them in place. 

The archive process begins.  

A progress dialog displays while archiving is taking place. When archiving is 
complete, a message displays indicating that the process has finished. 

If there is insufficient space on the DVD or CD to complete the archive, Total 
Recall Max  will archive as much as it can, and then prompt you to insert a new 
disc to complete the archive. 

If the DVD or CD is damaged and the archive fails, a message displays 
prompting you to insert another disc. 

 To archive manually to Network Share: 

1. Navigate to the Search Screen. 

2. Select the calls to archive by searching and/or tagging them. 

3. Select Archive. 

The Archive Calls dialog displays. 

 

4. In the Archive Calls field, select the types of call you wish to archive, from 
the following 4 options: 

·  All Calls (all calls currently on the hard disk) 

·  Found Calls (all calls that are currently listed in the Search Screen) 

·  Unarchived Calls (calls that have not been archived in the past) 

·  Tagged Calls 

As archive options are selected, Total Recall Max  displays the number of 
calls and the collective size of the calls (in MB). 

5. Select Network Share for Archive Device. 

The Type, Path, User and Password parameters for the network share 
must be pre-configured. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 
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6. Select OK. 

 If you have administrator privileges, a confirmation dialog displays 
asking if you would like to remove the calls that are archived from 
the hard disk. Select Yes to remove archived calls from the hard disk, 
or No to leave them in place. 

The archive process begins.  

A progress dialog displays while archiving is taking place. When archiving is 
complete, a message displays indicating that the process has finished. 

If there are problems with access to the Network Share, a message displays with 
information on the problem. If this is the case, the archive process fails until the 
problems are corrected. 

Automatic Archiving 

Automatic Archiving is configured via the Options Menu by a user with 
administrator privileges. 

With Auto Archive active, Total Recall Max  archives all unarchived calls on 
the hard disk at the frequency specified in the Archive settings. 

Total Recall Max  can also be configured to display a message reminding the 
user to manually archive when the hard disk reaches a specified percentage of 
capacity. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 

Deleting Calls 

Total Recall Max  is a secure recording system, and has been designed so that it 
is not possible to manually delete calls. 

However, archived calls are automatically deleted from the hard disk during 
manual archiving, if that option is selected. 

Also, calls are automatically deleted when: 

·  A set period of time has passed since they were recorded (for example, 3 
months). This option (Max. Call Lifetime) can only be activated by a user 
with administrator privileges. 

·  The number of calls on the hard disk reaches 350,000. When this happens, 
the oldest 50,000 archived calls are automatically deleted. If there are less 
than 50,000 archived calls, the oldest unarchived calls are also deleted until 
the number of calls on the hard drive is reduced to 300,000. 

·  The hard disk is 95% full. When this happens, the oldest archived calls are 
automatically deleted until the disk is only 88% full. If there are not enough 
archived calls, the oldest unarchived calls are also deleted until the disk is 
88% full. 

 Auto-deletion occurs according to the 3 conditions above in the 
priority that they are listed. To avoid losing unarchived calls as a 
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result of automatic deletion, it is important to be aware of recorder 
capacity and to ensure important calls are archived or saved regularly. 
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Remote Manager 
Overview 

Remote Manager  is Microsoft Windows® compatible software that allows 
remote access from a PC to one or more Total Recall Max recorders, via LAN 
or dialup. 

It can be used to:  

·  Configure the recorder 

·  Play recorded calls 

·  Monitor current calls in real-time 

·  Search the database 

·  Tag and notate calls on the database 

·  Download calls to the local hard drive 

·  Email downloaded calls 

·  Play and save calls from Total Recall Max  archive discs 

·  Generate reports 

·  Export calls to .wav or .mp3 

Installation and Initial Configuration 

Remote Manager  should only be installed and configured by a system 
administrator. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 
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User Interface 

Remote Manager  is a ‘tabbed’ application, including a Main Menu bar, a 
Button bar, and 4 tabs:  

·  Monitor 

·  Playback Calls 

·  TR Configuration  

·  Event Log  

 

Figure 6 - the Remote Manager User Interface  

Main Menu Bar 

The Remote Manager  main menu bar includes 2 menus – the File menu and 
the Help menu. 



Total Recall Max  – User Guide   

  Page 30 

File Menu 

 

The File menu includes the following options: 

·  Users 

Opens the Users dialog (administrators only). 

�  See Changing your Password or Display Language on page 
32 for more information. 

·  User Preferences 

Opens the User Preferences dialog.  

�  See Changing your Password or Display Language on page 
32 for more information. 

·  Save Call List as 

Saves the call list displayed in the Playback Calls tab as a .txt or .csv file. 
The data included reflects the current call list column configuration. 

·  Print Preview 

Opens a print preview of the Call Report.  

The Call Report is a print-formatted version of the call list displayed in the 
Playback Calls tab. The data included reflects the current call list column 
configuration. 

·  Print 

Prints the Call Report via the standard Windows print dialog. 

·  Advanced  

Opens the Advanced Settings dialog.  

Use the Advanced Settings dialog to set the local IP address for the PC, and 
the Manager Base Port. 

·  Exit 

Closes Remote Manager . 

Help Menu 
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The Help Menu provides access to:  

·  The Remote Manager  User Guide 

·  The Total Recall Max website 

·  FAQs on the web  

·  ‘About’ information (including the Remote Manager  version number) 

Button Bar 

 

The button bar provides access to most of the Remote Manager  administrative 
dialogs and functions. 

The table below lists the buttons and their uses. 

Button Use 

   
User Preferences Opens the User Preferences dialog.  

Use the User Preferences dialog to edit general 
user preferences and Total Recall Max 
connections* for the current user. 

   
Add TR Opens the Add Total Recall dialog. 

Use the Add Total Recall dialog to ‘add’* Total 
Recall Max recorders to the Remote Manager  
settings for the current user. 

   
Update Users  

(administrator users 
only) 

Opens the Update Users dialog. 

Use the Update Users dialog to add and remove 
users*, and to modify user preferences for all 
users in the user list. 

   
Refresh Views Refreshes the Device Tree and the Local 

Folders pane to reflect the latest changes. 

   
Change Language 
Settings 

Opens the Choose Language Settings dialog. 

Use the Choose Language Settings Dialog to 
specify the Remote Manager  UI display 
language. 

* Administrative functions 

�  See the Total Recall Max  Installation and Administration 
Guide for further information about administrative 
functionality available from the Button Bar. 
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Changing your Password or Display Language 

To change your Remote Manager  Password or display language: 

·  Click the User Preferences button:  

Or:  

·  Select File > User Preferences 

The dialog includes 2 tabs, General and TR Connectivity. 

Ensure the General tab is open. 

 

 To change the display language: 

1. Click the drop-down arrow to the right of the Language field and select 
your preferred language. 

2. Click OK. 

 To change your password: 

1. Click Change Password. 

2. Enter the new password in the Password field. 

3. Re-enter the password in the Confirm Password field. 

4. Click OK. 

 The TR Connectivity tab is used for system administration – check 
with your administrator before changing any settings on this tab. 
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Monitor Tab 

 

Figure 7 - the Monitoring Tab 

Use the Monitor  tab to monitor current calls, and to add notes to calls. 

Monitoring is only possible on extensions for which monitoring has been 
enabled. 

�  See the Total Recall Max  Installation and Administration 
Guide for further information. 

There are 2 ways to select calls for monitoring – by extension, and by channel. 

For analog recording, the signal sources are physically connected to individual 
channel inputs on the recorder, which means that each signal always comes into 
the recorder on the same channel. 

For example, if when the recorder is installed, PSTN telephone extension 2002 
is connected to channel 1 on the recorder, calls to and from extension 2002 will 
always be recorded on channel 1. 

However, for VoIP and ISDN calls, calls can come in on any one of a number 
of channels – there is no fixed relationship between a signal source and a 
channel. 

Monitoring by channel therefore is only really suitable for analog signals, and 
monitoring by extension is the better option for VoIP and ISDN calls. 
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It is also possible to monitor analog PSTN signals by extension, if called/calling 
number data is present in the signalling, or if the channels have been assigned 
extension values in the Analog Settings. 

TR Tree 

 

The TR Tree is an expandable/collapsible tree showing the connected Total 
Recall Max  recorders for the current user. 

Click on a recorder to select it. Functionality and information to the right of the 
TR Tree applies to the selected recorder. 

To update the TR Tree to reflect changes made to recorder connections, click 

the Refresh Views button:  

If Remote Manager  can not connect to a recorder, then it shows a cross on top 
of the icon next to the recorder name as shown on the subsequent screen 
capture. 

 

 

Monitoring Calls by Extension 

 

The Active Extensions panel displays a list of all current calls on the selected 
recorder that can be resolved to an extension.  



Total Recall Max  – User Guide   

  Page 35 

The call list is updated dynamically when new calls start and current calls 
finish. 

If a call comes in and cannot be immediately resolved to an extension, it will 
appear in the Live Monitor  panel (see below), and then also appear in the 
Active Extensions panel if and when the extension information becomes 
available. 

The Active Extension panel includes columns for: 

·  From number 

·  To number 

·  Direction (incoming / outgoing) 

·  Agent Name (if a ROD agent is logged in on the called or calling extension) 

·  Channel 

·  Extension 

 To select calls for monitoring by extension: 

1. In the TR Tree, select the recorder that you want to monitor. 

The call list in the Active Extensions panel is populated with all current calls 
that can be resolved to an extension. 

2. In the Active Extensions panel, click the call that you want to monitor. 

The call can be heard on the headphones/speakers. 

The channel on which the call is being recorded is highlighted in the Live 
Monitor panel. 

3. To stop monitoring, click the Stop Monitoring button, or select another call. 

Filtering the Call List 

You can filter the call list to show only calls that either match exactly, or begin 
with, the entered values. 

 To filter the calls listed in the Active Extensions  panel: 

1. Enter alphanumeric values in the Match extensions or Match numbers 
field. 

The call list is updated dynamically as values are entered. 

For example, to filter the call list to show only calls to or from extension 2006, 
enter 2006 in the Match extension field.  

To filter the call list to show only calls from all extensions in the range 2100-
2199, enter 29 in the Match number field. 

 Calls from all extensions that begin with 21 will be shown – for 
example, if your dial plan supports 3 and 4-digit extensions, calls 
from extensions 210-219 and calls from extensions 2100-2199 will be 
shown. 
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To filter the call list to show only calls to or from extension John Smith, enter 
John Smith in the Match extension field. 

To filter the call list to show only calls to or from number 0210 456 789, enter 
0210 456 789 in the Match number field. 

To filter the call list to show only calls to or from all numbers beginning 0210, 
enter 0210 in the Match number field. 

 This is a particularly useful function if you want to filter calls by area 
code. 

 To sort the call list: 

·  Click the relevant column header. 

Monitoring Calls by Channel 

 

The Live Monitor  panel displays a range of icons to indicate the status of each 
channel on the selected recorder. 

The icons are defined in the table below. 

Icon Channel Status 

  
Live call in progress. 

  
Monitoring in progress. 

  
Monitoring is active, but there is no activity on the line. 

   Monitoring is disabled - channel cannot be monitored. 

 Channel is unauthorised for the current user. 

The panel is automatically updated as and when each channel’s status changes. 

 To select calls for monitoring by channel: 

1. In the TR Tree, select the recorder that you want to monitor. 

2. In the Live Monitor  panel, click the channel icon for the channel that you 
want to monitor. The call can be heard on the headphones / speakers. 
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3. If the call can be resolved to an extension, the call is highlighted in the 
Active Extensions panel. 

4. To stop monitoring, click the Stop Monitoring button. 

Adding Notes 

Adding notes to calls is a handy way to record information about the call. 

Notes can be searched against in the Playback Calls tab. 

 See Searching for Calls > Note Keyword on page 44 for further 
information. 

 To add a note to a call: 

1. Select the call in the Active Extensions panel, or an active channel in the 
Live Monitor panel. 

2. Type the note in the Add Notes text field. The field supports up to 80 
characters. 

3. Click Add Note. 

The note is added to the call.  

 

If the call is returned as the result of a search in the Playback Calls tab, the 
first few characters of the note appears in the Notes column for that call, 
from where it can also be viewed and edited. 
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Playback Calls Tab 

 

Use the Playback Calls tab to search for and play recorded calls, from:  

·  Connected Total Recall  recorders 

·  Total Recall  archives on DVD/CD 

·  Total Recall  archives Network Share 

·  Local Folders (configured folders on local or network hard drives) 
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The Device Tree 

 

The Device Tree is an expandable/collapsible tree showing for the current user: 

1. local DVD/CD drives; 

2. configured Local Folders; 

3. configured Network Shares; and  

4. the connected Total Recall Max  recorders. 

Click on an item to select it. Functionality and information to the right of the 
Device Tree applies to the selected recorder. 

Click the  icon for a device to see the lower-level date and extension nodes. 

To update the Device Tree to reflect changes made to recorder connections, 

click the Refresh Views button:  

To view the Device Tree sorted by date, select the Sort by Date tab. 
Otherwise, to view the Device Tree sorted by extension, select the Sort by 
extension tab. 

DVD/CD Drives 

DVD/CD Drives appear in the Device Tree where they can be selected for 
searching. 
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 To add a DVD/CD drive : 

1. In the Device Tree, right click on ‘DVD/CD Drives’ 

2. Click Select Drive. 

The Configure DVD/CD ROM dialog appears. 

 

3. Select the DVD/CD Drive Letter of the DVD/DC drive on your local 
machine.  

4. Click Ok. 

The drive now appears in the Device Tree. 

Local Folders 

Local Folders are configured folders on local or network drives into which calls 
can be saved, individually or in groups, and which can then be searched from 
within Remote Manager . 

 

Local Folders appear in the Device Tree, where they can be selected for 
searching, and where calls can be saved via drag and drop from another 
location. 

�  See Saving Multiple Calls to Local Folders on page 46 for 
further information on saving calls to Local Folders. 

 To add local folders: 

1. In the Device Tree, right click on ‘Local Folders’ 

2. Click Add Folder. 

3. Navigate to an existing folder or create a new folder. This can be a folder on 
your local drive or on another machine. 

4. Click Open. 

The new local folder will now appear in the Device Tree. 
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 To remove existing local folders: 

1. In the device tree, expand the list of Local Folders. 

2. Right click on the local folder that you want to remove. 

3. Click Remove Folder in the drop down menu. 

 To refresh local folders: 

·  On the button bar, click the Refresh Views button   

Or:  

·  Right click on the Local Folder in the Device Tree, and click Refresh 
Folder in the drop down menu. 

Refreshing local folders updates the device tree with any changes made to 
Local Folders outside of Remote Manager . 

Network Shares 

Network Shares are specifically configured folders on local or network 
locations. They are set up in order to allow for the automatic or manual 
archiving of calls from your Total Recall Max  recorder to network storage. 
Calls on a Network Share may be searched via Remote Manager  or from your 
Total Recall Max  recorder. 

 

Network Shares appear in the Device Tree where they can be selected for 
searching. 

 To add network shares: 

1. Right click on ‘Network Shares’ in the device tree. 

2. Click Add Shares in the dropdown menu. 

3. Select the appropriate network share type and file path, as well as providing 
the username and password for the network share location (where 
applicable). Your system administrator will supply these details. 

4. Click OK to confirm settings. 

To minimise unnecessary use of your network bandwidth, network share 
location(s) are not automatically connected for immediate search and replay. To 
access archives on a network share location, you must ‘attach’ the location 
manually. 
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 To attach/detach existing network shares: 

1. In the device tree, expand the list of ‘Network Shares’ to view currently 
installed Network Share locations. 

2. Right click on the specific Network Share location that you wish to attach 
or detach. 

3. Click Attach Share or Detach Share in the drop down menu. 

An attached network share will remain attached and available for immediate 
searching while you remain in the ‘Playback Calls’ tab. Selecting another tab 
will cause the network share to automatically detach. 

 The network share device tree follows the structure of Network Share 
Location > Unit ID > Date of Archive > Date of Calls/Extensions 
(setting dependant). 

 To remove a network share: 

1. In the device tree, expand the list of network shares to view currently 
installed Network Share locations. 

2. Right click on the specific Network Share location that you wish to remove. 

3. Click Remove Share in the dropdown menu. 

Total Recalls 

The device Tree also shows the connected Total Recall Max  recorders for the 
current user. 

 

Total Recall Max  recorders appear in the Device Tree where they can be 
selected for searching. 
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Searching for Calls 

 To search for calls: 

1. In the Device Tree, select a DVD/CD Drive, Local Folder, network Share 
or a Total Recall Max  recorder that you want to search. 

2. Enter any appropriate search criteria (see below for more information). 

3. Click Search Now. 

The matched calls (up to a maximum of 1000 calls) are displayed in the call 
list. 

 

If no search criteria are entered, all calls on the selected device/s are 
returned. 

·  To see more results (if over 1000 calls are returned) click  . 

·  To return to the first 1000 results, click Search Now again. 

Using Search Criteria 

 

The following types of information can be used as search criteria: 

·  Date 

·  Time 

·  Extension 

·  Phone Number 

·  Call Length 

·  Note Keyword 

·  Call Direction 

·  Local Folder 

·  Agent Name 

Search criteria are cumulative – only calls that match all specified criteria are 
returned. The more criteria entered, the more specific the result. 

Date 

To search for calls that were recorded after a certain date, click the Date from 
button and select a date from the calendar. 
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To search for calls that were recorded before a certain date, click the Date to 
button and select a date from the calendar. 

If a date node is selected in the Device Tree, the Date from and Date to fields 
are automatically populated with the appropriate date value. 

Time 

To search for calls that fall within a certain time range, click either of the Time 
from or Time To buttons, and set a time range using the sliders. 

To set a time interval that spans midnight, set the To value to be less than the 
From value. The To value is then considered to be that time the next day. 

Extension 

To search for calls by extension, select Extension and enter an extension value 
in the text field (alpha and/or numeric). 

If an extension node is selected in the Device Tree, the Extension checkbox is 
automatically selected, and the text field is populated with the appropriate 
extension value. 

Phone Number 

To search for calls by phone number, select Phone Number and enter a 
numeric value in the text field.  

Calls to or from the entered number are returned. 

Call Length 

To search for calls by call length, select Call Length and click the associated 
button:  

Set the call length range using the sliders. 

If the minimum value is not set, all calls shorter than the maximum setting are 
returned. 

If the maximum value is not set, all calls longer than the minimum value are 
returned. 

Note Keyword 

To search for calls by note keyword, select Note Keyword and enter the 
keyword/s in the text field. 

Calls matching all the specified keywords are returned. 

Call Direction 

To search for calls by call direction, select Call Direction and choose an option 
from the drop-down list. 

Options are: 

·  In (incoming calls) 

·  Out (outgoing calls) 

·  Internal (calls between internal extensions) 
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·  Unknown (Total Recall  cannot determine the call direction) 

Local Folder 

To search for calls by local folder, select Local Folder and click the folder 
from the Device Tree, or paste the full system path for the local folder into the 
text field. 

If a local folder is selected in the Device Tree at any time, the Local Folder 
checkbox is automatically selected, and the text field is populated with the 
appropriate system path. 

Agent Name 

To search for calls made by a ROD agent select Agent Name and then select 
the agent’s name from the drop down box. 

Playing Calls 

When a search is complete, the results are displayed in the Call List . 

 

 To play a call from the call list: 

·  Select the call in the Call List  and click �  

Or: 

·  Double-click the call in the call list. 

The call is played through the headphones/speakers. 

The progress through the call is displayed for reference. 

To pause playback, click � . 

To stop playback, click � . 

To begin playback part-way through a call, drag the time slider to the required 
point, and click � . 

Saving Recordings 

Saving Single Calls from the Call List 

You can save single calls individually as .mp3, .wav or .trc (Total Recall Max  
proprietary format) files. 
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 To save individual calls: 

1. Select the call in the call list. 

2. Click  . 

3. Navigate to the appropriate save location. 

4. Enter a filename and select the required file format. 

5. Click Save. 

Saving Multiple Calls to Local Folders 

You can save groups of calls (as .trc files only) to Local Folders. 

�  See Local Folders on page 40 for information about Local 
Folders. 

 To save groups of calls: 

1. Select the calls in the call list. 

Use Ctrl + click to select multiple non-consecutive calls, and Shift + click to select 
multiple consecutive calls. 

2. Drag the calls to the appropriate Local Folder in the Device Tree. 

 Calls that are dragged and dropped into Local Folders are not deleted 
from the recorder. 

Emailing Recordings 

You can email calls as .mp3, .wav or .trc files. 

 To email calls: 

1. Select the calls in the call list. 

2. Click  . 

3. Select the required audio format. 

4. Click OK. 

A blank email is created (using the system default email client) with the 
calls already attached. 

Deleting Recordings 

You can only delete calls from local folders. 

 To delete calls from a local folder: 

1. Select the call/s in the call list. 

2. Click  . 
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Notes 

You can add notes to calls on remote Total Recall Max  recorders, in Local 
Folders, and in Network Share. 

 To add a note to a call: 

1. Select the note in the call list. 

2. Click  . 

The Add Note dialog displays. 

3. Type the note in the Add Notes text field. The field supports up to 80 
characters. 

4. Click OK. 

 To delete a note from a call: 

1. Select the relevant call in the call list. 

2. Click  . 

The Add Note dialog displays. 

3. Click Clear. 

4. Click OK. 

Customising the Call List 

The call list is customisable. The available columns are: 

·  Date (Total Recall Max ) 

·  Time (Total Recall Max ) 

·  Date (Local ) 

·  Time (Local) 

·  Length 

·  Number 

·  Direction 

·  Status 

·  Channel 

·  Notes 

·  Recorder ID 

·  Agent Name 

·  To Extension 

·  From Extension 

·  To Number (Mapped) 

·  From Number (Mapped) 

·  DTMF Digits 
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 To customise the call list: 

1. Click  . 

2. Select the columns you want to include in the call list. 

3. Click OK.  

Event Log Tab 

Use the Event Log tab to view a record of system events for the selected 
recorder. 

 

Event Types 

The Event Log may contain 3 types of event: 

  Information 

Information events are standard system events and do not require any further 
action. 

  Warnings 

Warnings are events that may indicate possible future problems, and should be 
investigated – for example, failed database searches and power failures. 
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  Errors 

Errors are events that must be investigated immediately, such as database 
rebuild failures, auto-archive failures, and DSP card issues. 

Security Audits 

In addition to providing an activity log for system administration, the Event 
Log provides an audit trail of user activity that can be referred to in the event of 
security issues. 

Viewing Events 

Select a recorder in the TR Tree to view events for that recorder. 

To filter the Event Log, click the button for the event type that you wish to 
view. 

To refresh the Event Log, click  . 

The Event Log can hold approximately 100,000 entries. When the Event Log is 
full, new entries automatically overwrite old entries. 

The contents of the Event Log can be selected and copied out into a text editor 
to allow keyword searches. 
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Record On Demand 
Overview 

Record on Demand  (ROD) is an optional Windows®-compatible client 
application that provides additional real-time recording control to Total Recall 
Max end users (usually agents). 

 

Utilising an existing LAN connection, users can start and stop the recording of 
current calls, control which calls on their line are recorded and which aren’t, 
and add notes to current calls – all from a simple taskbar application on the 
user’s PC.  

If a user requires ROD functionality but does not have immediate access to a 
PC, recording can also be controlled by the use of configurable codes entered 
on a user’s phone.  

ROD functionality is configured (either as a ‘global’ setting across all 
extensions, or on an individual extension basis) on the Total Recall Max unit 
itself, or in Remote Manager .  

�  See the Total Recall Max  Installation and Administration 
Guide for information about configuring ROD. 

Installation and Initial Configuration 

ROD should only be installed and configured by a system administrator.  

�  See the Total Recall Max  Installation and Administration 
Guide for information about installing ROD. 



Total Recall Max  – User Guide   

  Page 51 

Using ROD 

Logging In 

 To log in to ROD: 

1. Start the ROD application (double-click the desktop icon, or select TR 
Record on Demand from the Windows Start menu). 

2. Select your Agent Name from the drop-down list. 

3. Click Login. 

4. Enter your password. 

5. Click OK. 

ROD can now be used to control recording (and/or add notes to calls) on the 
configured extension. 

Recording 

To toggle recording on and off, click the recording button. 

When the recorder is not recording, the record button is labelled ‘Not 
Recording’ and appears in the ‘up’ state: 

 

When the recorder is recording, the record button is labelled ‘Recording’ and 
appears in the ‘down’ state, with a flashing red LED icon: 

 

Logout and Refresh 

To log out, click Logout. 

 As a security measure, it is advisable to log out whenever you leave 
your PC. 

If new agents have been added whilst ROD is open, click Refresh to update the 
agent list. 

Adding Notes 

 To add a note to a current call: 

1. Type the note into the text box. The text box supports up to 60 characters. 

2. Click Add Note. 
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Configuration 

The Configure button allows access to the Total Recall Max  connection details 
and the recorded extension setting. 

Only users with administrator privileges can access the Configuration dialog. 

�  See the Total Recall Max  Installation and Administration 
Guide for information about configuring ROD. 
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Glossary 
CLI 

Calling Line Identification 

A telephony intelligent network service that transmits the caller's telephone 
number and in some places the caller's name to the called party's telephone 
equipment during the ringing signal or when the call is being set up but before 
the call is answered. 

CDR 

Call Detail Record 

Also called Call Detail Recording or SMDR (Station Message Detail 
Recording), CDR is a record containing information about recent system usage, 
including the identities of sources (points of origin), the identities of 
destinations (endpoints), and the duration of each call. 

D/A 

Digital to Analog 

A digital-to-analog converter (DAC or D-to-A) is a device for converting a 
digital (usually binary) code to an analog signal (current, voltage or electric 
charge). 

DSP 

Digital Signal Processor 

A specialized microprocessor designed specifically for digital signal 
processing, generally in real-time computing. 

DTMF 

Dual-Tone Multi-Frequency 

Used for telephone signalling over the line in the voice-frequency band to the 
call switching centre. The version of DTMF used for telephone tone dialling is 
known by the trademarked term Touch-Tone, and is standardised by ITU-T 
Recommendation Q.23. Other multi-frequency systems are used for signalling 
internal to the telephone network. 

FTP 

File Transfer Protocol 

A commonly used protocol for exchanging files over any network that supports 
the TCP/IP protocol (such as the Internet or an intranet).  
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IDF 

 Intermediate Distribution Frame 

A frame that (a) cross-connects the user cable media to individual user line 
circuits and (b) may serve as a distribution point for multi-pair cables from the 
main distribution frame (MDF) or combined distribution frame (CDF) to 
individual cables connected to equipment in areas remote from these frames. 

IP 

Internet Protocol 

A data-oriented protocol used for communicating data across a packet-switched 
internetwork. 

IP is a network layer protocol in the internet protocol suite and is encapsulated 
in a data link layer protocol (e.g., Ethernet). As a lower layer protocol, IP 
provides the service of communicable unique global addressing amongst 
computers. 

ISDN 

Integrated Services Digital Network 

A circuit-switched telephone network system, designed to allow digital 
transmission of voice and data over ordinary telephone copper wires, resulting 
in better quality and higher speeds than that available with the PSTN system. 

LAN 

Local Area Network 

A computer network covering a small geographic area, like a home, office, or 
group of buildings. 

LCD 

Liquid Crystal Display  

A thin, flat display device made up of any number of colour or monochrome 
pixels arrayed in front of a light source or reflector. 

MDF 

Main Distribution Frame 

A signal distribution frame for connecting equipment (inside plant) to cables 
and subscriber carrier equipment (outside plant). 

NTP 

Network Time Protocol 

A protocol for synchronizing the clocks of computer systems over packet-
switched, variable-latency data networks. NTP uses UDP port 123 as its 
transport layer. It is designed particularly to resist the effects of variable latency 
(Jitter). 
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PBX 

Private Branch Exchange 

Also called Private Business eXchange, or PABX (Private Automatic Branch 
eXchange), a PBX is a telephone exchange that serves a particular business or 
office, as opposed to one a common carrier or telephone company operates for 
many businesses or for the general public. 

PSTN 

Public Switched Telephone Network 

The network of the world's public circuit-switched telephone networks. 

QoS 

Quality of Service 

Control mechanisms that can provide different priority to different users or data 
flows, or guarantee a certain level of performance to a data flow in accordance 
with requests from the application program. 

RTP 

Real-time Transport Protocol 

The Real-time Transport Protocol (or RTP) defines a standardized packet 
format for delivering audio and video over the Internet. 

SIP 

Session Initiation Protocol 

An application-layer control (signalling) protocol for creating, modifying, and 
terminating sessions with one or more participants. These sessions include 
Internet telephone calls, multimedia distribution, and multimedia conferences. 

TCP 

Transmission Control Protocol 

One of the core protocols of the Internet protocol suite, often simply referred to 
as TCP/IP. Using TCP, applications on networked hosts can create connections 
to one another, over which they can exchange streams of data using Stream 
Sockets.  

UDP 

User Datagram Protocol 

The User Datagram Protocol (UDP) is one of the core protocols of the Internet 
protocol suite. Using UDP, programs on networked computers can send short 
messages sometimes known as datagrams (using Datagram Sockets) to one 
another. UDP is sometimes called the Universal Datagram Protocol. 
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UPS 

Uninterruptible Power Supply 

A device which maintains a continuous supply of electric power to connected 
equipment by supplying power from a separate source when utility power is not 
available. 

VLAN 

Virtual LAN 

A method of creating independent logical networks within a physical network. 

VoIP 

Voice over Internet Protocol 

Also called VoIP, IP Telephony, Internet telephony, Broadband telephony, 
Broadband Phone and Voice over Broadband, VoIP is the routing of voice 
conversations over the Internet or through any other IP-based network. 

VOX 

Voice Operated Switch 

A vox or voice operated switch is a switch that operates when sound over a 
certain threshold is detected. 

WAN 

Wide Area Network 

A computer network that covers a broad area (i.e., any network whose 
communications links cross metropolitan, regional, or national boundaries). Or, 
less formally, a network that uses routers and public communications links. 

 Definitions courtesy of Wikipedia 
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Legal 
The Total Recall Max  requires Linux kernel and modules to operate. These 
come from the Fedora Core 5 distribution and are covered by the GNU General 
Public License (GPL) which is enclosed here for your review (as obtained from  
http://www.gnu.org/copyleft/gpl.html). 

The Total Recall Max, Remote Manager  and Record on Demand  software 
are distributed under the Comsec TR Software License. 

Comsec TR Software License 

End-User Licence Agreement for Comsec TR Software – Total Recal Max, 
Remote Manager & Record on Demand. 

IMPORTANT     -  READ CAREFULLY:   

This Comsec TR Software Licence Agreement (“CSLA”) is a legal agreement 
between you (either an individual or a single entity) and Comsec TR Pty Ltd for 
the Comsec TR software product identified above, which includes computer 
software and associated media and printed materials, and may include “online” 
or electronic documentation (“SOFTWARE PRODUCT” or “SOFTWARE”). 
By installing, copying, or otherwise using the SOFTWARE PRODUCT, you 
agree to be bound by the terms of this CSLA. If you do not agree to the terms of 
this CSLA, promptly return the unused SOFTWARE PRODUCT to the place 
from which you obtained it. 

SOFTWARE PRODUCT LICENCE 

The SOFTWARE PRODUCT is protected by copyright laws and international 
copyright treaties, as well as other intellectual property laws and treaties. The 
SOFTWARE PRODUCT is licensed, not sold. 

GRANT OF LICEN CE  

This CSLA grants you the following rights: 

The software and hardware described in this document are furnished under a 
licence agreement and may be used only in accordance with the terms of the 
agreement. The software that accompanies all Comsec TR products is the 
property of Comsec TR Pty Ltd (ABN 40 051 658 569), and is protected by 
copyright law. While Comsec TR continues to own the software, you will have 
certain limited rights to use the software after your acceptance of this licence. 
Except as may be modified by a license addendum which accompanies this 
licence, your rights and obligations with respect to the use of this software are 
as follows: 

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS 

Limitations on Reverse Engineering, Decompilation, and Disassembly: You 
may not reverse engineer, decompile, or disassemble the SOFTWARE 
PRODUCT, except and only to the extent that such activity is expressly 
permitted by applicable law not withstanding this limitation. 
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Termination: Without prejudice to any other rights, Comsec TR may terminate 
this CSLA if you fail to comply with the terms and conditions of this CSLA. In 
such event, you must destroy all copies of the SOFTWARE PRODUCT and all 
of its component parts. 

UPGRADES 

If the SOFTWARE PRODUCT is an upgrade of an Comsec TR product, you 
now may use that upgraded product only in accordance with this CSLA. 

COPYRIGHT 

All titles and copyrights in and to the SOFTWARE PRODUCT (including but 
not limited to any images, photographs, animations, video, audio, music, text, 
and “applets,” incorporated into the SOFTWARE PRODUCT), the 
accompanying printed materials, and any copies of the SOFTWARE 
PRODUCT, are owned by Comsec TR or its suppliers. The SOFTWARE 
PRODUCT is protected by copyright laws and international treaty provisions. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES 

To the maximum extent permitted by applicable law, in no event shall Comsec 
TR or its suppliers be liable for any special, incidental, indirect, or 
consequential damages whatsoever (including, without limitation, damages for 
loss of business profits, business interruption, loss of business information, or 
any other pecuniary loss) arising out of the use of or inability to use the 
software product, even if Comsec TR has been advised of the possibility of 
such damages. 

MISCELLANEOUS 

The developer, Comsec TR Pty Ltd has adopted a policy to continue the 
development of Total Recal Max, Remote Manager and Record on Demand and 
therefore there may be variations between the documentation and the operating 
system at any one time. 

Should you have any questions concerning this CSLA, or if you desire to 
contact Comsec TR for any reason, please contact the Comsec TR reseller 
serving your country, or write to: 

Comsec TR Pty Ltd  

PO Box 572 

Milsons Point, NSW 1565  

Australia 
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GNU Public License 
GNU GENERAL PUBLIC LICENSE 

Version 3, 29 June 2007 

Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/> 

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed. 

PREAMBLE 

The GNU General Public License is a free, copyleft license for software and other kinds of works. 

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By 
contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a program--to 
make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public License for 
most of our software; it applies also to any other work released this way by its authors. You can apply it to your programs, too. 

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that 
you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or can get 
it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do these 
things. 

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you 
have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of 
others. 

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same 
freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them these 
terms so they know their rights. 

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this 
License giving you legal permission to copy, distribute and/or modify it. 

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' 
and authors' sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attributed 
erroneously to authors of previous versions. 

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the 
manufacturer can do so. This is fundamentally incompatible with the aim of protecting users' freedom to change the software. The 
systematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most 
unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems arise 
substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to 
protect the freedom of users. 

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use 
of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free 
program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the program 
non-free. 

The precise terms and conditions for copying, distribution and modification follow. 

TERMS AND CONDITIONS 

0. Definitions. 

“This License” refers to version 3 of the GNU General Public License. 

“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks. 

“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as “you”. “Licensees” and 
“recipients” may be individuals or organizations. 
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To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the 
making of an exact copy. The resulting work is called a “modified version” of the earlier work or a work “based on” the earlier 
work. 

A “covered work” means either the unmodified Program or a work based on the Program. 

To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable for 
infringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation includes 
copying, distribution (with or without modification), making available to the public, and in some countries other activities as well. 

To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a 
user through a computer network, with no transfer of a copy, is not conveying. 

An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently visible 
feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the 
extent that warranties are provided), that licensees may convey the work under this License, and how to view a copy of this License. 
If the interface presents a list of user commands or options, such as a menu, a prominent item in the list meets this criterion. 

1. Source Code. 

The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any non-
source form of a work. 

A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in the case 
of interfaces specified for a particular programming language, one that is widely used among developers working in that language. 

The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in the normal 
form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only to enable use of the 
work with that Major Component, or to implement a Standard Interface for which an implementation is available to the public in 
source code form. A “Major Component”, in this context, means a major essential component (kernel, window system, and so on) of 
the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code 
interpreter used to run it. 

The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for an 
executable work) run the object code and to modify the work, including scripts to control those activities. However, it does not 
include the work's System Libraries, or general-purpose tools or generally available free programs which are used unmodified in 
performing those activities but which are not part of the work. For example, Corresponding Source includes interface definition files 
associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work 
is specifically designed to require, such as by intimate data communication or control flow between those subprograms and other 
parts of the work. 

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding 
Source. 

The Corresponding Source for a work in source code form is that same work. 

2. Basic Permissions. 

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated 
conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output from 
running a covered work is covered by this License only if the output, given its content, constitutes a covered work. This License 
acknowledges your rights of fair use or other equivalent, as provided by copyright law. 

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise 
remains in force. You may convey covered works to others for the sole purpose of having them make modifications exclusively for 
you, or provide you with facilities for running those works, provided that you comply with the terms of this License in conveying all 
material for which you do not control copyright. Those thus making or running the covered works for you must do so exclusively on 
your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material 
outside their relationship with you. 

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 
10 makes it unnecessary. 

3. Protecting Users' Legal Rights From Anti-Circumvention Law. 
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No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under 
article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of 
such measures. 

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such 
circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any intention to 
limit operation or modification of the work as a means of enforcing, against the work's users, your or third parties' legal rights to 
forbid circumvention of technological measures. 

4. Conveying Verbatim Copies. 

You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously 
and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this License and any non-
permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence of any warranty; and give 
all recipients a copy of this License along with the Program. 

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee. 

5. Conveying Modified Source Versions. 

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code 
under the terms of section 4, provided that you also meet all of these conditions: 

·  a) The work must carry prominent notices stating that you modified it, and giving a relevant date.  

·  b) The work must carry prominent notices stating that it is released under this License and any conditions added under 
section 7. This requirement modifies the requirement in section 4 to “keep intact all notices”.  

·  c) You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This 
License will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its 
parts, regardless of how they are packaged. This License gives no permission to license the work in any other way, but it 
does not invalidate such permission if you have separately received it.  

·  d) If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has 
interactive interfaces that do not display Appropriate Legal Notices, your work need not make them do so.  

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered 
work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is 
called an “aggregate” if the compilation and its resulting copyright are not used to limit the access or legal rights of the 
compilation's users beyond what the individual works permit. Inclusion of a covered work in an aggregate does not cause this 
License to apply to the other parts of the aggregate. 

6. Conveying Non-Source Forms. 

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the 
machine-readable Corresponding Source under the terms of this License, in one of these ways: 

·  a) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), 
accompanied by the Corresponding Source fixed on a durable physical medium customarily used for software 
interchange.  

·  b) Convey the object code in, or embodied in, a physical product (including a physical distribution medium), 
accompanied by a written offer, valid for at least three years and valid for as long as you offer spare parts or customer 
support for that product model, to give anyone who possesses the object code either (1) a copy of the Corresponding 
Source for all the software in the product that is covered by this License, on a durable physical medium customarily used 
for software interchange, for a price no more than your reasonable cost of physically performing this conveying of 
source, or (2) access to copy the Corresponding Source from a network server at no charge.  

·  c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. 
This alternative is allowed only occasionally and noncommercially, and only if you received the object code with such an 
offer, in accord with subsection 6b.  

·  d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access 
to the Corresponding Source in the same way through the same place at no further charge. You need not require 
recipients to copy the Corresponding Source along with the object code. If the place to copy the object code is a network 
server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent 
copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding 
Source. Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for 
as long as needed to satisfy these requirements.  

·  e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and 
Corresponding Source of the work are being offered to the general public at no charge under subsection 6d.  
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A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not 
be included in conveying the object code work. 

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used for 
personal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining whether 
a product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product received by a 
particular user, “normally used” refers to a typical or common use of that class of product, regardless of the status of the particular 
user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer 
product regardless of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent 
the only significant mode of use of the product. 

“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required to 
install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding Source. 
The information must suffice to ensure that the continued functioning of the modified object code is in no case prevented or 
interfered with solely because modification has been made. 

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs 
as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in perpetuity or for 
a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under this section must be 
accompanied by the Installation Information. But this requirement does not apply if neither you nor any third party retains the ability 
to install modified object code on the User Product (for example, the work has been installed in ROM). 

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, 
or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has been modified or 
installed. Access to a network may be denied when the modification itself materially and adversely affects the operation of the 
network or violates the rules and protocols for communication across the network. 

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is 
publicly documented (and with an implementation available to the public in source code form), and must require no special 
password or key for unpacking, reading or copying. 

7. Additional Terms. 

“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its 
conditions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in this 
License, to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, that part 
may be used separately under those permissions, but the entire Program remains governed by this License without regard to the 
additional permissions. 

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any 
part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the work.) You 
may place additional permissions on material, added by you to a covered work, for which you have or can give appropriate 
copyright permission. 

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the 
copyright holders of that material) supplement the terms of this License with terms: 

·  a) Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or  

·  b) Requiring preservation of specified reasonable legal notices or author attributions in that material or in the 
Appropriate Legal Notices displayed by works containing it; or  

·  c) Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be 
marked in reasonable ways as different from the original version; or  

·  d) Limiting the use for publicity purposes of names of licensors or authors of the material; or  

·  e) Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or  

·  f) Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified 
versions of it) with contractual assumptions of liability to the recipient, for any liability that these contractual 
assumptions directly impose on those licensors and authors.  

All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program as 
you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a further 
restriction, you may remove that term. If a license document contains a further restriction but permits relicensing or conveying 
under this License, you may add to a covered work material governed by the terms of that license document, provided that the 
further restriction does not survive such relicensing or conveying. 

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the 
additional terms that apply to those files, or a notice indicating where to find the applicable terms. 
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Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; 
the above requirements apply either way. 

8. Termination. 

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to 
propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses granted 
under the third paragraph of section 11). 

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) 
provisionally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the 
copyright holder fails to notify you of the violation by some reasonable means prior to 60 days after the cessation. 

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the 
violation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) from 
that copyright holder, and you cure the violation prior to 30 days after your receipt of the notice. 

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you 
under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new licenses 
for the same material under section 10. 

9. Acceptance Not Required for Having Copies. 

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered 
work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. 
However, nothing other than this License grants you permission to propagate or modify any covered work. These actions infringe 
copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you indicate your acceptance 
of this License to do so. 

10. Automatic Licensing of Downstream Recipients. 

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and 
propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this License. 

An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an 
organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party to that 
transaction who receives a copy of the work also receives whatever licenses to the work the party's predecessor in interest had or 
could give under the previous paragraph, plus a right to possession of the Corresponding Source of the work from the predecessor in 
interest, if the predecessor has it or can get it with reasonable efforts. 

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you 
may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not initiate 
litigation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, using, selling, 
offering for sale, or importing the Program or any portion of it. 

11. Patents. 

A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is 
based. The work thus licensed is called the contributor's “contributor version”. 

A contributor's “essential patent claims” are all patent claims owned or controlled by the contributor, whether already acquired or 
hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its contributor 
version, but do not include claims that would be infringed only as a consequence of further modification of the contributor version. 
For purposes of this definition, “control” includes the right to grant patent sublicenses in a manner consistent with the requirements 
of this License. 

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, 
to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version. 

In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not to enforce 
a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To “grant” such a patent 
license to a party means to make such an agreement or commitment not to enforce a patent against the party. 

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for 
anyone to copy, free of charge and under the terms of this License, through a publicly available network server or other readily 
accessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange to deprive yourself of 
the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the requirements of this License, 
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to extend the patent license to downstream recipients. “Knowingly relying” means you have actual knowledge that, but for the 
patent license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would 
infringe one or more identifiable patents in that country that you have reason to believe are valid. 

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a 
covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, propagate, 
modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended to all recipients of 
the covered work and works based on it. 

A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned 
on the non-exercise of one or more of the rights that are specifically granted under this License. You may not convey a covered 
work if you are a party to an arrangement with a third party that is in the business of distributing software, under which you make 
payment to the third party based on the extent of your activity of conveying the work, and under which the third party grants, to any 
of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the 
covered work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or 
compilations that contain the covered work, unless you entered into that arrangement, or that patent license was granted, prior to 28 
March 2007. 

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may 
otherwise be available to you under applicable patent law. 

12. No Surrender of Others' Freedom. 

If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, 
they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy simultaneously 
your obligations under this License and any other pertinent obligations, then as a consequence you may not convey it at all. For 
example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom you convey the 
Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program. 

13. Use with the GNU Affero General Public License. 

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work 
licensed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting work. 
The terms of this License will continue to apply to the part which is the covered work, but the special requirements of the GNU 
Affero General Public License, section 13, concerning interaction through a network will apply to the combination as such. 

14. Revised Versions of this License. 

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. 
Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns. 

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General 
Public License “or any later version” applies to it, you have the option of following the terms and conditions either of that numbered 
version or of any later version published by the Free Software Foundation. If the Program does not specify a version number of the 
GNU General Public License, you may choose any version ever published by the Free Software Foundation. 

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's 
public statement of acceptance of a version permanently authorizes you to choose that version for the Program. 

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any 
author or copyright holder as a result of your choosing to follow a later version. 

15. Disclaimer of Warranty. 

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT 
WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE 
PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE 
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION. 

16. Limitation of Liability. 

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT 
HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE 
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
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DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO 
LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES 
OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR 
OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

17. Interpretation of Sections 15 and 16. 

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, 
reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with the 
Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee. 

END OF TERMS AND CONDITIONS 

 


